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Introduction

Topics in this chapter:

B Overview on page 1
B About this Guide on page 2
B Contacting Customer Support on page 3

Overview

Autodesk® WiretapCentral™ is a fully integrated Web application that provides interactive access to all media
assets in your facility network. It presents editorial, visual effects, and grading assets stored on any
network-accessible Stone filesystem or standard filesystem framestore.

The intuitive Web interface eliminates the need to be at an Autodesk creative workstation to import, play,
encode media, or to submit and monitor background jobs. This allows the artist to offload media management
and transcoding, and stay focused on creative tasks.

WiretapCentral straddles several different technologies, including Autodesk Visual Effects, Finishing and
Colour Grading workstations, low-bandwidth Web video, and several different networking and collaboration
protocols and tools.
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WiretapCentral enables you to directly import REDCODE RAW and multi-channel OpenEXR files by leveraging
the Autodesk® Wiretap® Gateway.

When importing media, WiretapCentral can use Autodesk® Backburner™ distributed background processing
to maximize efficiency.

About this Guide

Notation Conventions

A number of style conventions are used throughout your documentation. These conventions and examples
of their use are shown as follows.

Convention Example

Text that you enter in a command line or shell appears install rpm -ga
in Courier bold. Press the Enter key after each com-
mand.

Variable names appear in Courier, enclosed in angle <filename>
brackets.

Feedback from the command line or shell appearsin ~ 1imit coredumpsize
Courier.

Directory names, filenames, URLs, and command line  /usr/discreet
utilities appear in italics.

Related Documentation

Documentation for this release is installed with the product as PDF files and as an HTML help system, and
is also available on the Autodesk web site at http://www.autodesk.com/me-documentation. From this page you
can access the complete documentation library.

You should also refer to the product release notes for all late-breaking release information.
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Contacting Customer Support

For Autodesk Media and Entertainment Customer Support, visit http://www.autodesk.com/support.

Customer support is also available through your Autodesk reseller. To find a reseller near you, consult the
reseller look-up database at http://www.autodesk.com/resellers.
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Concepts

Topics in this chapter:

Wiretap on page 5
WiretapCentral on page 5
Wiretap Gateway on page 6
Autodesk Wire on page 6
Autodesk Backburner on page 6
Media I/O Adapter on page 7

Wiretap

WiretapCentral communicates with media and metadata databases through their Wiretap® server, typically
an Autodesk Visual Effects, Finishing, and Colour Grading workstation.

The Visual Effects and Finishing Wiretap server (ifffsWiretapServer) is installed automatically with Visual
Effects and Finishing applications, and requires no modification for WiretapCentral. The server runs
automatically and independently of the Visual Effects and Finishing application.

Fach workstation is listed in the WiretapCentral network tree as a member of the Wiretap network.

WiretapCentral

The WiretapCentral Web server receives requests from the WiretapCentral Ul, and routes them to the
appropriate Wiretap server.

Media is transferred from the media storage through a GigE or InfiniBand® network to WiretapCentral where
it is converted to an .FLV thumbnail and/or preview, as required.

WiretapCentral also performs media encoding, and stores the exported clips and export packages.



The WiretapCentral U is an Adobe® Flash® Player compatible rich Internet application (RIA) that runs in
a standard Web browser. It communicates solely with the WiretapCentral Web server. Once WiretapCentral
has converted the high-bandwidth media from the framestore into a light-weight .FLV clip, the only media
transaction that occurs between the WiretapCentral Web server and Ul is a progressive download.

Wiretap Gateway

The Wiretap Gateway is a Wiretap server that exposes any mounted standard filesystem as a Wiretap hierarchy
of directories, files, and clip nodes, which it automatically detects.

The Wiretap Gateway reads image media in any format from any storage device, and streams it live as raw
RGB to local or remote Wiretap clients, such as WiretapCentral. Any Wiretap-enabled application can use
the Wiretap Gateway to move media.

For Visual Effects and Finishing applications, Wiretap Gateway is leveraged by WiretapCentral to decode
various media formats, including RED RAW and OpenEXR, or to move media from an Autodesk Visual
Effects and Finishing application Stone® storage to Autodesk® Lustre® direct attached storage.

For Autodesk Lustre, Wiretap Gateway is used natively by the Lustre file browser to browse files and
decode/transcode media. You use Wiretap Gateway to expose the contents of a file system, for example RED
(.r3d), QuickTime® (.mov), and MXF (.mxf) media. Since decompressing compressed media is a CPU intensive
task, performance may vary based on your system configuration.

Wiretap Gateway machines in your network are labeled as such in the WiretapCentral network tree, or in
the Lustre file browser. They act as gateways to the storage devices where the media to import resides.

When you select a Wiretap Gateway machine, and initiate a media import operation, the media is read from
the source storage by the Wiretap Gateway, processed by the Media I/O Adapter encoding engines on the
processing nodes, and then written to the destination storage through the Wiretap server.

Autodesk Wire

The Autodesk® Wire® service enables high-speed transfer of uncompressed timelines, clips, and libraries
between Autodesk workstations, on industry-standard TCP/IP and InfiniBand® networks, preserving all
metadata.

For more information on Autodesk Wire, see the Autodesk Stone and Wire Filesystem and Networking Guide.

Autodesk Backburner

Autodesk Backburner is the Autodesk queue manager for background processing and distributed network
processing. It provides the means to submit, monitor, and control processing and media I/O jobs.

The Backburner architecture consists of the following components:

B Backburner Manager Coordinates jobs submitted by Wiretap clients, and delegates them to the Wiretap
servers on the Wiretap network.

B Backburner Monitor Front-end interfaces for management and control of the Backburner Manager.
B Backburner Server The job-processing component of Backburner that invokes the processing engine.

B Backburner Processing Engine  The server-side process responsible for processing frames. Processing
engines integrate themselves in Backburner Server as plug-ins or adapters.

B Backburner Processing Node Processing nodes are dedicated machines on the Backburner network
that consist of a Backburner Server, plug-ins/adapters, and processing engines. The Backburner Server
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receives job assignments from the Backburner Manager, and passes them on to the correct processing
engine through the plug-in/adapter.

For detailed information about Backburner components, see the Autodesk Backburner Installation Guide.

Media /O Adapter

The Media I/O Adapter is a Backburner processing engine that reads media from a storage device or Wiretap
server, processes it, and then writes it to a storage device or Wiretap server.

Media I/0O Adapter | 7






Installing WiretapCentral
and Wiretap Gateway

Topics in this chapter:

Choosing a Deployment Model on page 9

Preparing Your Installation on page 10

Stand-alone Installation on page 11

Distributed Deployment on page 12

Licensing Wiretap Gateway on page 20

Setting up the Automount Service on Backburner Server Nodes on page 22
Configuring Wiretap Gateway on page 23

Setting Up User Access Control for WiretapCentral on page 24

Web Browser Configuration on page 26

Verifying Installed Components on page 26

Choosing a Deployment Model

There are two main deployment models for WiretapCentral and Wiretap Gateway. Both models allow you
to browse, encode, and decode media, but the ease of installation and level of performance differ.

B Stand-alone installation  This is the easiest installation model, as all components are installed and
configured on a single Visual Effects and Finishing workstation, or Autodesk Lustre Linux® workstation.
This deployment model is suitable for media browsing with occasional media encoding and decoding,
as it offers the lowest level of performance.

B Distributed deployment This advanced deployment model offers increased performance, as processing
is distributed across several dedicated Backburner Server nodes on your network. This is a scalable
deployment model: performance can be maximized by moving as many components as possible onto



dedicated machines on your network. This is the only supported deployment model for Lustre Windows®
workstations, or for an Incinerator® network.

The following sections provide information and installation instructions for each deployment option. Choose
the configuration that best suits your needs.

Preparing Your Installation

Before you begin installing WiretapCentral and Wiretap Gateway, perform the following steps to prepare
for the installation. Some of these tasks must be performed from a computer connected to the Internet.

1

Decide which deployment model you want to use. Refer to the descriptions in the previous section.

2 Obtain your installation media. All necessary components for a stand-alone or distributed deployment

setup are available from the installation directory of the Autodesk Visual Effects, Finishing and Colour
Grading application. You can get the application installation package on DVD (for major releases) or
you can download it as a tar file (for major releases, extensions, and service packs). The download link
is provided in the Release Announcement you received from Autodesk.

NOTE You can also download each component individually, as a tar file. Backburner is also available as a zip
file, for Windows. The download links for all components are in the Release Announcement you received
from Autodesk.

Download the latest version of the Autodesk Backburner Installation Guide, Autodesk Backburner User Guide,
and your application installation and configuration guide from www.autodesk.com/me-documentation.

Although reading these guides is not required for your installation, the present document occasionally
refers to them for additional details or for definitions of important concepts.

If you are performing a distributed deployment, make sure the systems you plan to install the various
components on meet the following recommended specifications.

Component Hardware Operating System Other Requirements
WiretapCentral B 64-bit, dual-core CPU, 64-bit Red Hat® Enterprise Linux® B Direct access to the
such as AMD™ Opter- Desktop 5.3, or Autodesk Wiretap
on™, or Intel® Xeon® 64-bit Red Hat Enterprise Linux network. Wiretap-
H 1 GB of RAM or better. Workstation 4 update 3 Central must reside
on the same subnet
B GigE or InfiniBand net- NOTE It is recommended to as the Visual Effects,
working disable SELinux on the Wireta- Finishing and Colour
W 500 GB Hard Drive, or pCentral machine. Grading workstations
larger using it.

B Apache Web Server
version 2.0.52 or
later.

64-bit dual core CPU Any 64-bit Linux distribution Direct connection to the
SAN/NAS/DAS media
storage in your facility.

Wiretap Gateway

B 1 GB of RAM or better
B GigE or InfiniBand

Backburner Server B 64-bit dual core CPU Any 64-bit Linux distribution
and
Media I/O Adapter

1 GB of RAM or better
GigE or InfiniBand

10 | Chapter 3 Installing WiretapCentral and Wiretap Gateway


www.autodesk.com/me-documentation

NOTE If you have Autodesk® Burn® render nodes in your facility, you can use them as Backburner Servers
and Media I/O Adapters. These components are automatically installed with the latest version of the Burn
software. See the latest Autodesk Burn Installation and User Guide for details about Autodesk Burn.

Stand-alone Installation

In a stand-alone installation, Wiretap Gateway, WiretapCentral, and all background processing components
(Backburner Server, Backburner Manager, and the Media I/O Adapter) are installed on the same workstation
as the Visual Effects, Finishing and Colour Grading application.

A stand-alone installation is the easiest deployment model, as all necessary components are automatically
set up by the Visual Effects, Finishing, and Colour Grading application installer. However, all media processing
is performed locally, which can have a significant impact on system performance if you are using several
components at the same time.

NOTE This deployment model is only applicable for a Linux (not Incinerator) Lustre workstation.

To set up a stand-alone configuration on a Visual Effects and Finishing workstation:

1
2

Open a terminal, and log in as root.

Download the Visual Effects and Finishing installation package from the link provided in the Release
Announcement you received from Autodesk, and unpack it into a temporary directory by typing:

tar -zxvf <file name>.targz

Browse to the Visual Effects and Finishing application installation directory, and run the application
installation script by typing:
./INSTALL <APPLICATION NAME>

Click Yes when the installation scripts asks if you want to automatically run Backburner Manager and
Backburner Server on the local machine.

Click Yes when the installation script asks if you want to enter a Backburner Manager for the Server.
The manager configuration file opens in a text editor. Make sure the local manager address, localhost,
is set in the file.

If the installer detects changes in your Wiretap Gateway configuration file
(/usr/discreet/wiretapgateway/cfg/wiretapgateway.cfg), your existing configuration file and the new
configuration file are open side by side in an xxdiff window.

Each difference between the old and the new wiretapgateway.cfg files is highlighted in xxdiff. Review
the differences and click on the correct value for each keyword, regardless of whether it is in the left or
right panel. Make sure you select a value for each highlighted difference. Then open the File menu and
choose Save as Right. After the file is saved, close xxdiff to continue the installation process.

Perform the remaining steps of a regular application installation, as guided by the application installer.
Refer to the latest Autodesk Visual Effects and Finishing Installation and Configuration Guide for additional
details.

Wiretap Gateway, WiretapCentral, and all background processing components are automatically installed
and configured on the workstation.

License Wiretap Gateway. See Licensing Wiretap Gateway on page 20.
Configure Wiretap Gateway. See Configuring Wiretap Gateway on page 23.

Optional: Password-protect WiretapCentral and create user names and passwords for each user. See
Setting Up User Access Control for WiretapCentral on page 24.

Stand-alone Installation | 11



11 Make sure the Web browsers on the computers you plan to access WiretapCentral from are properly
configured. See Web Browser Configuration on page 26.

12 Verify that all components have been properly installed. See Verifying Installed Components on page
26.

To set up a stand-alone configuration on a Lustre Linux workstation:
1 Open a terminal, and log in as root.
2 Download the Lustre Linux installation package from the link provided in the Release Announcement
you received from Autodesk, and unpack it into a temporary directory by typing:

tar -zxvf <file name>.targz

3 Browse to the Lustre installation directory, and run the application installation script by typing:
./INSTALL LUSTRE <version>

4 If the installer detects changes in your Wiretap Gateway configuration file
(/usr/discreet/wiretapgateway/cfg/wiretapgateway.cfg), your existing configuration file and the new
configuration file are open side by side in an xxdiff window.

Each difference between the old and the new wiretapgateway.cfg files is highlighted in xxdiff. Review
the differences and click on the correct value for each keyword, regardless of whether it is in the left or
right panel. Make sure you select a value for each highlighted difference. Then open the File menu and
choose Save as Right. After the file is saved, close xxdiff to continue the installation process.

5 Perform the remaining steps of a regular application installation, as guided by the application installer.
Refer to the latest Autodesk Lustre Installation and Configuration Guide for Linux Workstations for details.
Wiretap Gateway, WiretapCentral, and all background processing components are automatically installed
and configured on the workstation.

6 License Wiretap Gateway. See Licensing Wiretap Gateway on page 20.

7 Configure Wiretap Gateway. See Configuring Wiretap Gateway on page 23.

8 Verify that all components have been properly installed. See Verifying Installed Components on page
26.

As mentioned earlier, in a stand-alone deployment all media processing takes place locally, and system
resources are shared between such background tasks and the Visual Effects, Finishing and Colour Grading
application running in the foreground.

To avoid competition for workstation resources and to increase productivity, it is recommended that you
relocate some or all of the components to dedicated machines on your network. The following section
describes the levels of scalability a distributed deployment offers.

Distributed Deployment

Although more complex to set up, a distributed deployment offers the highest level of flexibility and
performance for media decoding, as it allows the CPU-intensive background processing to be off-loaded
from the Visual Effects, Finishing and Colour Grading workstation and distributed across a Backburner
processing network for increased productivity.

Depending on your performance needs, you can scale your configuration as much as necessary. Here are
some examples of typical deployment scenarios.

12 | Chapter 3 Installing WiretapCentral and Wiretap Gateway



Example #1: Wiretap Gateway Residing on the Visual Effects, Finishing and Colour Grading Workstation

In this scenario, WiretapCentral, Backburner Manager, and Wiretap Gateway run on the Visual Effects,
Finishing and Colour Grading workstation, while processing is performed by several dedicated nodes in a
render farm. Each processing node comprises a Backburner Server and a Media I/O Adapter.

The following diagrams depict this deployment model for a Visual Effects and Finishing workstation, and
for a Lustre Linux (non-Incinerator) workstation.

NOTE This deployment model is not applicable to a Lustre Windows or an Incinerator setup.

Flame / Smoke’

Standard FS

1
1
1
1
1
1
1
1
: Stone FS /
1
1
1
1
1
1
1
1

Wiretap
{ WiretapCentral ’ Gateway

Backburner

Manager

Processing Node

Backburner
Server

y Media
/| /O Adapter

Storage

Processing Node

Backburner

Manager

|

[ Backburner
: Server
|
|

. Media
/| /O Adapter

TIP Since processing components (Backburner Server and the Media 1/O Adapter) are automatically installed on
Visual Effects, Finishing and Colour Grading workstations, the workstations themselves can be used as processing

nodes during off-peak hours.
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To set up Wiretap Gateway and a Visual Effects and Finishing application on the same workstation:

1
2

10

Open a terminal, and log in as root.

Download the Visual Effects and Finishing installation package from the link provided in the Release
Announcement you received from Autodesk, and unpack it into a temporary directory by typing:
tar -zxvf <file name>.targz

The installation package is unpacked into a new directory.

Browse to the newly-created installation directory, and run the application installation script by typing:
./ INSTALL <APPLICATION NAME>

Click Yes when the installation script asks if you want to automatically run it on the local workstation.

Click Yes when the installation script asks if you want to automatically run Backburner Server on the
local machine.

Click Yes when the installation script asks if you want to enter a Backburner Manager for the Server.
The manager configuration file opens in a text editor. Enter the hostname of the machine where
Backburner Manager will be installed. By default, this value is set to localhost.

If the installer detects changes in your Wiretap Gateway configuration file
(/usr/discreet/wiretapgateway/cfg/wiretapgateway.cfg), your existing configuration file and the new
configuration file are open side by side in an xxdiff window.

Each difference between the old and the new wiretapgateway.cf files is highlighted in xxdiff. Review
the differences and click on the correct value for each keyword, regardless of whether it is in the left or
right panel. Make sure you select a value for each highlighted difference. Then open the File menu and
choose Save as Right. After the file is saved, close xxdiff to continue the installation process.

Perform the remaining steps of a regular application installation, as guided by the application installer.
Refer to the latest Autodesk Visual Effects and Finishing Installation and Configuration Guide for details.

The application, WiretapCentral, and Wiretap Gateway are installed and configured on the workstation.

If you want to use existing Burn render nodes as processing nodes, upgrade to the latest version of Burn,
and skip to step 12.

Backburner Server and the Media I/O Adapter are automatically installed with the latest version of
Autodesk Burn. See the Autodesk Burn Installation and User Guide for Burn installation instructions.

Perform the following tasks to install Backburner Server on non-Burn systems that you want to use as
processing nodes:

B Log in as root and access the Visual Effects and Finishing application installation package.

B Go to the dist subdirectory of the installation directory, and type:
rpm -Uhv backburner*

B Click No when the installer asks if you want to automatically run Backburner Manager on this
machine.

B Click Yes when the installer asks if you want to automatically run Backburner Server on this machine.

B Click Yes when the installation script asks if you want to enter a Backburner Manager for the Server.
The manager configuration file /usr/discreet/backburner/cfg/manager.host opens. Enter the hostname
of the Visual Effects and Finishing workstation.

NOTE You can also configure this setting later by opening the /usr/discreet/backburner/cfg/manager.host
file in a text editor.
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11

12

13

14

15
16

17

18

19

Install the Media I/O Adapter on the Backburner Server nodes. While you are still in the dist subdirectory
of the Visual Effects and Finishing application installation package, type:

./autodesk.mio.INSTALL

Optional: Group your Backburner Server nodes into server groups.

This is an optional, but highly recommended task. Server groups provide an efficient way of organizing
the way your background processing jobs get distributed to the render farm. Consult the latest Autodesk
Backburner User Guide for information on creating server groups.

NOTE You can include your Visual Effects and Finishing workstation in a server group, as well, if you wish to
use it as a processing node during off-peak hours.

Make sure the mount points on all the machines involved in the setup are identical. Failure to perform
this step might prevent your processing network from processing jobs.

NOTE Wiretap Gateway does not index “blind” mount points. To make “blind” mount points visible to
Wiretap Gateway, create permanent symbolic links to them.

License Wiretap Gateway on each machine where you installed it. See Licensing Wiretap Gateway on
page 20.

Configure Wiretap Gateway. See Configuring Wiretap Gateway on page 23.

Configure the amd and NFS services on each Backburner Server node. See Setting up the Automount
Service on Backburner Server Nodes on page 22.

Optional: Password protect WiretapCentral and create user names and passwords for each user. See
Setting Up User Access Control for WiretapCentral on page 24.

Make sure the Web browsers on the computers you plan to access WiretapCentral from are properly
configured. See Web Browser Configuration on page 26.

Verify that all components have been properly installed. See Verifying Installed Components on page
26.

To set up Wiretap Gateway and Autodesk Lustre on the same Linux workstation:

1
2

Open a terminal, and log in as root.

Download the Lustre Linux installation package from the link provided in the Release Announcement
you received from Autodesk, and unpack it into a temporary directory by typing:

tar -zxvf <file name>.tar.gz

The installation package is unpacked into a new directory.

Browse to the newly-created Lustre installation directory, and run the application installation script by
typing:
./INSTALL LUSTRE <version>

If the installer detects changes in your Wiretap Gateway configuration file
(/usr/discreet/wiretapgateway/cfg/wiretapgateway.cfg), your existing configuration file and the new
configuration file are open side by side in an xxdiff window.

Each difference between the old and the new wiretapgateway.cfg files is highlighted in xxdiff. Review
the differences and click on the correct value for each keyword, regardless of whether it is in the left or
right panel. Make sure you select a value for each highlighted difference. Then open the File menu and
choose Save as Right. After the file is saved, close xxdiff to continue the installation process.
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10
11

Perform the remaining steps of a regular application installation, as guided by the application installer.
Refer to the Autodesk Lustre Installation and Configuration Guide for Linux Workstations.

Lustre, BrowseD,Wiretap Gateway, and Backburner Manager are installed on the workstation.

Install the Burn for Lustre package on each processing node by running the installation script, as root.
Type:
./INSTALL LUSTRE <version>_ BURN

This installs the Backburner server and Media I/O adapter on each node.

Optional: Group your Backburner Server nodes into server groups.

This is an optional, but highly recommended task. Server groups provide an efficient way of organizing
the way your background processing jobs get distributed to the render farm. Consult the latest Autodesk
Backburner User Guide for information on creating server groups.

NOTE You can include your Lustre workstation in a server group, as well, if you wish to use it as a processing
node during off-peak hours.

Make sure the mount points on all the machines involved in the setup are identical. Failure to perform
this step might prevent your processing network from processing jobs.

NOTE Wiretap Gateway does not index “blind” mount points. To make “blind” mount points visible to
Wiretap Gateway, create permanent symbolic links to them.

License Wiretap Gateway on each machine where you installed it. See Licensing Wiretap Gateway on
page 20.

Configure Wiretap Gateway. See Configuring Wiretap Gateway on page 23.

Verify that all components have been properly installed. See Verifying Installed Components on page
26.

Example #2: Wiretap Gateway Residing on a Dedicated Machine

In this scenario, each component resides on a dedicated machine on the network. Media processing is
performed by processing nodes bundled in node groups in a render farm.

This deployment model can also be used with Lustre Windows, as Wiretap Gateway is installed on a separate
Linux machine.

The following diagrams depict this deployment model for a Visual Effects and Finishing workstation, and
for a Lustre Linux (non-Incinerator) or Windows workstation.
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Perform the following steps to set up WiretapCentral, Wiretap Gateway and Backburner Manager on dedicated
machines. Most of the installation steps are similar to the procedures in Example #1: Wiretap Gateway
Residing on the Visual Effects, Finishing and Colour Grading Workstation on page 13. This procedure
provides details only for the steps that are new or different from Example #1.

To set up Wiretap Gateway and Backburner Manager on dedicated machines:

1 Download and install the Visual Effects and Finishing or Lustre application on the workstation (for
Lustre, the workstation can be either a Linux or a Windows workstation).

NOTE If you are installing a Visual Effects and Finishing application, answer No to the question about
automatically running Backburner Manager on the workstation.

2 Perform the following tasks to install Wiretap Gateway on a dedicated machine on your network:
B Log in to the system as root.

B Access the Visual Effects and Finishing application installation package, or the Lustre Linux
installation package.

B If you are using a Visual Effects and Finishing installation package, go into the dist subdirectory,
and run the Wiretap Gateway installation script by typing:
./autodesk.wiretapgateway.INSTALL
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B If you are using a Lustre installation package, type the following to run the Wiretap Gateway
installation script, located in the main directory of the Lustre installation package:
./INSTALL_WIRETAP_GATEWAY_SERVER

Wiretap Gateway is installed on the machine.

3 Perform the following tasks to install WiretapCentral on a dedicated machine:
B Log in to the system as root.

B Access the Visual Effects and Finishing application installation package.

B Go into the dist subdirectory, and run the WiretapCentral installation script by typing:
./autodesk.wiretapcentral.INSTALL

WiretapCentral is installed on the system.

4 Perform the following tasks to install Backburner Manager on a dedicated Linux or Windows machine
on your network:

B Download the Backburner installation package for Linux or Windows from the links provided in
the Release Announcement you received from Autodesk.

B To install Backburner Manager on a Windows system, unpack the zip file and double-click the
backburner.exe installation file.

B To install Backburner Manager on a Linux system, open a terminal as root, and type the following
sequence of commands:
tar -zxvf backburner<version> LINUX.tar.gz
cd backburner<version>_ LINUX
./INSTALL

Answer Yes to the question about automatically running Backburner Manager, and No to the question
about automatically running Backburner Server.

5 Upgrade Burn or Burn for Lustre on each processing node. Backburner Server and the Media I/O Adapter
are automatically upgraded with Burn. For instructions on installing Burn see the Autodesk Burn Installation
and User Guide, or the Autodesk Lustre Installation and Configuration Guide for Linux Workstations.

6 If you want to use non-Burn systems as processing nodes, install or upgrade Backburner Server and the
Media I/O Adapter on each processing node.

7 Optional: Group your Backburner Server nodes into server groups. See the latest Autodesk Backburner
User Guide.

NOTE You can include your Visual Effects, Finishing and Colour Grading workstation in a server group as
well, if you wish to use it as a processing node during off-peak hours.

8 Make sure the mount points on all the machines involved in the setup are identical. Failure to perform
this step might prevent your processing network from processing jobs.

9 License Wiretap Gateway on each machine where you installed it. See Licensing Wiretap Gateway on
page 20.

10 Configure Wiretap Gateway. See Configuring Wiretap Gateway on page 23.

11 Configure the amd and NFS services on each Backburner Server node. See Setting up the Automount
Service on Backburner Server Nodes on page 22.

12 Optional: Password protect WiretapCentral and create user names and passwords for each user. See
Setting Up User Access Control for WiretapCentral on page 24.

18 | Chapter 3 Installing WiretapCentral and Wiretap Gateway



13 Make sure the Web browsers on the computers you plan to access WiretapCentral from are properly
configured. See Web Browser Configuration on page 26.

14 Verify that all components have been properly installed. See Verifying Installed Components on page
26.

Example #3: Incinerator With Wiretap Gateway

In this deployment model, Lustre is installed on an Incinerator system, Wiretap Gateway is installed on the
Lustre Media Server, and the processing nodes are on a render farm.
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To set up Wiretap Gateway with the Incinerator system:
1 Download the Incinerator installation package from the link provided in the Release Announcement
you received from Autodesk, and unpack it into a temporary directory by typing:
tar -zxvf <file name>.tar.gz

The installation package is unpacked into a new directory.
2 Open a terminal on the workstation and log in as root.

3 Browse to the Incinerator installation directory, and run the application installation script by typing:
./INSTALL LUSTRE <version> INCINERATOR

Lustre, BrowseD and Backburner Manager are installed on the workstation.

4 Log in to the Lustre Media Server as root, access the Incinerator installation package, and install the
server by typing:
. /INSTALL_LUSTRE_<verS ion>_ SERVER

BrowseD, cmanagerd, client, and Wiretap Gateway are installed on the Lustre Media Server.

5 If the installer detects changes in your Wiretap Gateway configuration file
(/usr/discreet/wiretapgateway/cfg/wiretapgateway.cfg), your existing configuration file and the new
configuration file are open side by side in an xxdiff window.

Each difference between the old and the new wiretapgateway.cf files is highlighted in xxdiff. Review
the differences and click on the correct value for each keyword, regardless of whether it is in the left or
right panel. Make sure you select a value for each highlighted difference. Then open the File menu and
choose Save as Right. After the file is saved, close xxdiff to continue the installation process.

Distributed Deployment | 19



6 Install the render node package on each processing node by running the installation script, as root.
Type:
./INSTALL LUSTRE <version> RENDERNODE

This installs the Backburner server, Media I/O adapter and renderd on each node.

7 License the Wiretap Gateway on each machine where you installed it. See Licensing Wiretap Gateway
on page 20.

8 Configure Wiretap Gateway. See Configuring Wiretap Gateway on page 23.

9 Verify that all components have been properly installed. See Verifying Installed Components on page
26.

Licensing Wiretap Gateway

You cannot use Wiretap Gateway until you enter a license code for it.

Unlicensed Wiretap Gateway machines are labeled as such in the WiretapCentral Server Details panel and
in the Lustre file browser.

budapest-

eway Server (Unlicensed)

ver (Unlice

Although they still appear in the network tree, unlicensed Wiretap Gateways block all media I/O. When you
attempt to play or import media through an unlicensed Wiretap Gateway, the operation fails and an
“Unlicensed” error message is returned.

Name

0 of clip /DLlocal/images/expression_jcon_sam.jpg@CLIP on server 172.16.131,192:7183: Unlicensed

Unrenderable Frame

Mone
Perform the following procedure on each Wiretap Gateway machine to license it.

To license Wiretap Gateway:
1 Obtain the Discreet host ID of the Wiretap Gateway machine. Open a terminal and type:
dlhostid
The following line should be part of the output:

The Discreet host ID of this machine is
“DLHOST01=25231AEF83ADI9DSEOB2FA270DF4F20B1”
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2 Send the Discreet host ID (including the DLHOSTO1= part) to the Autodesk Licensing Department to
obtain the Wiretap Gateway license code.

B ByE-mail To acquire alicense code by e-mail, submit a request with the host ID of the workstation
to me.licensing@autodesk.com.

B By Telephone You can speak to a licensing representative by calling the Licensing Department
toll-free in North America at 1-800-925-6442 between 8 AM and 8 PM EST. Outside of North America,
call 1-514-954-7199.

NOTE For emergencies, you can acquire an immediate temporary emergency license using the emergency
license generator at http://melicensing.autodesk.com/templicensing/. A 4-day license code is e-mailed to
the address you provide.

You will receive a license code similar to the following:

FEATURE wiretapgw all 2010 discreet 1 2010.999 15-oct-2009 0 \
4D7A8424FC43EOF86A65 \
HOSTID=DLHOST01=25231AEF83ADI9D5E9B2FA270DF4F20B1 ck=31

NOTE The code above is just an example. Actual license codes are unique for each Wiretap Gateway machine.

3 On the Wiretap Gateway machine, open the file /usr/local/flexIm/licenses/DL_license.dat in a text editor
(such as nano) and enter the license code.

NOTE Edit this file with care; an incorrect character or missing space may prevent Wiretap Gateway from
recognizing the license.

4 Save and close the DL _license.dat file, then restart Wiretap Gateway by typing:
/etc/init.d/wiretapgateway restart

5 To verify that Wiretap Gateway was successfully licensed, perform one of the following tasks:

B Open WiretapCentral in a Web browser, and select the Gateway machine in the network tree.
The Description row in the Server Details panel should no longer contain the mention “Unlicensed”.

budapest-server:Gat

2010.0.0 (Build 266)
172.16.131.112

B In Lustre, view the file browser in the Edit > Browse menu.
Wiretap Gateway should no longer contain the mention “Unlicensed”.
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Setting up the Automount Service on Backburner Server
Nodes

The amd (automount daemon) and NFS services need to be properly configured on each Backburner Server
node in order for the node to be able to access project/library metadata on the Visual Effect and Finishing
workstation that submits a background processing job.

NES access to the Linux workstations at /hosts/<hostname> is required, where <hostname> is the name
of each workstation submitting background processing jobs.

If the amd and NFS services are not running or are not properly configured on a Backburner Server node,
you get an error similar to the following when you try to submit a background processing job to the node:

Notice : NoticeDescription: Creating clips on parent node
'/stonefs/Project name/Library name' on host '192.168.1.72:7549".

Notice : ErrorDescription: Can't create clip in parent node
'/stonefs/Project name/Library name' on host '192.168.1.72:7549"'

Perform the following procedure on each node to configure the amd and NFS services.

To configure the amd and NFS services:
1 Login as root to the Backburner Server node.

2 Stop the amd automounter daemon by typing:
/etc/init.d/amd stop

3 Open the /etc/amd.conf configuration file in a text editor.
4 Locate the following lines:

#DEFINE AN AMD MOUNT POINT
[ /net ]

5 Change /net to /hosts.
The lines should now be the following:
#DEFINE AN AMD MOUNT POINT
[ /hosts ]

6 Configure the NFS and amd services to start automatically, by typing the following commands:
chkconfig nfs on

chkconfig amd on

7 Confirm that the NFS and amd services are configured to start at run-levels 2 to 5, by typing:
chkconfig --list | egrep ‘nfs|amd’
The output of the command should contain the following lines:
nfs O:off 1l:0ff 2:on 3:on 4:on 5:on 6:0ff
amd O:0ff 1l:0ff 2:0on 3:on 4:on 5:on 6:0ff

8 Reboot the node to ensure all network settings take effect. Type:

reboot
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Configuring Wiretap Gateway

The Wiretap Gateway configuration file, /usr/discreet/wiretapgateway/cfg/wiretapgateway.cfg contains a number
of settings for Wiretap Gateway.

This section covers some of the most important settings you may want to adjust in the configuration file.
For details on each parameter, refer to the comments inside the configuration file.

Defining an Additional IP Address

By default, the primary network interface of Wiretap Gateway is the GigE network adapter. If you are using
an additional network, such as an InfiniBand network, uncomment the IP0 parameter in the
Jusr/discreet/wiretapgateway/cfg/wiretapgateway.cfg configuration file, and set its value to the InfiniBand IP
address of the host. For example:

IP0=10.10.11.10

If you need to define more network interfaces, use the IP1, IP2, parameters, and so on.

Excluding Directories and File Types

By default, Wiretap Gateway exposes all directories and files on the machine where it is installed. You can
change this behavior by defining lists of directories and file types that should not be exposed by Wiretap
Gateway.

To exclude certain directories from being exposed by Wiretap Gateway, uncomment the ExcludeDirs
parameter in the /usr/discreet/wiretapgateway/cfg/wiretapgateway.cfg configuration file, and set its value to a
comma-separated list of directories. For example:

ExcludeDirs=/dev, /1lib, /usr/1lib, /bin, /usr/bin, /sbin

To exclude certain file types from being exposed by Wiretap Gateway, uncomment the ExcludeExts
parameter in the configuration and set its value to a comma-separated list of file extensions. For example:

ExcludeExts=jpg, tiff, mov

If there are just a few directories that you want to expose through Wiretap Gateway, it is more efficient to
use the LimitDirs parameter to specify just the directories that should be exposed, rather than using
ExcludeDirs to exclude all the other directories in the system. For example:

LimitDirs=/mnt

NOTE LimitDirs overrides ExcludeDirs in the event of a conflict.

Configuring Proxy Quality for RED Footage

When viewing proxies of RED (R3D) media, you may want to change the proxy quality level, for smoother
playback. Use the LowresDebayerMode keyword in the /usr/discreet/wiretapgateway/cfg/wiretapgateway.cfg
configuration file to change the quality level.

The keyword can take one of the following values:
m Full
B Half Premium

m Half Good
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B Quarter

m Fighth

NOTE The default value is Quarter.

For example, the following Lustre system setups should have the LowresDebayerMode keyword set to
the following values to achieve real-time playback.

Hardware LowresDebayerMode Value
HP® Z800 with HP Z800 media server Quarter

HP xw8600 with HP xw8600 media server Quarter

HP xw8400 with HP xw9400 media server Eighth

Setting up Wiretap Gateway Slave Processes

To improve real-time playback of RED media, Wiretap Gateway can spawn multiple slave processes that
increase performance without requiring additional licenses.

To configure Wiretap Gateway to start slave processes, open the configuration file
/usr/discreet/wiretapgateway/cfg/wiretapgateway.cfg in a text editor, uncomment the NumLocalSlaves
keyword, and set its value to the number of slave processes you want to run on the machine.

If you are running Wiretap Gateway on a dedicated system, enable as many slave processes as the number
of CPU cores on the system. If you are running Wiretap Gateway on a Visual Effects, Finishing and Colour
Grading workstation, make sure you set aside at least 4 CPU cores for a Visual Effects and Finishing application,
or 2 cores for Lustre.

If you plan to also run other applications and processes on the Wiretap Gateway system, reduce the number
of slaves accordingly.

For example, on a 16-core HP® Z800 workstation running Autodesk® Lustre®, enable 12 Wiretap Gateway
slave processes, so that 2 CPU cores remain available for the Lustre application, and 2 other CPU cores are
available for background processes, such as Backburner.

Setting Up User Access Control for WiretapCentral

By default, no user name or password is needed to use WiretapCentral, and all jobs submitted from
WiretapCentral to Backburner are owned by the generic user “apache”. As a result, all users can perform
operations on any WiretapCentral job on the Backburner network, including suspending, activating, and
deleting jobs submitted by other users.

For greater control, you can password-protect the WiretapCentral root directory using the Apache server’s
basic authentication mechanism. Once password-protection is in place, users are required to submit a user
name and password to access WiretapCentral. With password-protection enabled, WiretapCentral jobs on
the Backburner network then have specific user names associated with them. Only the owner of a job can
perform operations upon it. Optionally, you can give administrator privileges to specific users so they can
control Backburner jobs other than their own.

NOTE If you decide not to implement user access control, you might still want to assign the generic user “apache”
administrator privileges for Backburner. This will allow all WiretapCentral users to manage and control all jobs on
the Backburner network, including Burn jobs, for example.
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Step 1: Password-Protecting the WiretapCentral Directory

The first step in setting up user authentication is to password-protect the directory (and subdirectories) from
which the WiretapCentral Web page is served. This is done by adding standard server directives to the main
Apache configuration file.

1 Open the main Apache configuration file, /etc/httpd/conf/httpd.conf in a text editor.

2 Scroll to the bottom of the file and add the following lines, then save and close the file:
#
# WiretapCentral User Authentication Section
#
<Directory /var/www/html/wiretapcentral>
AuthType Basic
AuthName WireTapCentral
AuthUserFile /etc/httpd/auth/wiretapcentral.auth
<Limit GET POST>
require valid-user
</Limit>

</Directory>

3 Restart the Apache server for the changes to take effect. Type:
/etc/init.d/httpd restart

4 Verify that password protected was successful by opening a browser and attempting to use
WiretapCentral:

http://<hostname>/WiretapCentral

A pop-up dialog should appear, indicating WiretapCentral requires a valid user name and password.

Step 2: Populating the User/Password File
With the WiretapCentral directory password-protected, you can now create a password file containing user
names and passwords.
1 Check if the wiretapcentral.auth file exists in the /etc/httpd/auth/ directory, by typing the following:
1ls /etc/httpd/auth
If the file is listed in the command output, the correct file is already in place, and you do not need to
create it.
2 Use the Apache htpasswd command to add users to the wiretapcentral.auth file:
htpasswd -c -b /etc/httpd/auth/wiretapcentral.auth <username> <password>

The -c option replaces any existing password file. Use this option for the first password only, if
wiretapcentral.auth is not already in place.

The -b (batch mode) option adds the user name and password in one step. Omitting the -b option
causes Apache to prompt you for the password in a separate step, and avoids displaying the password
in plain-text as you type it.

3 Optional: To delete an account type:
htpasswd -D /etc/httpd/auth/backburner.auth <username>
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Step 3 (Optional): Giving Specific Users Administrator Privileges

Users without administrators privileges can perform operations on the jobs they themselves submit, but can
only monitor other jobs on the Backburner network. Users with administrator privileges can actively manage
all jobs and render nodes. Administrator privileges are assigned in the Backburner configuration file,
Jusr/discreet/backburner/cfg/wiretap.cfg.

1 On the workstation where the Backburner Manager is installed, open the
/usr/discreet/backburner/cfg/wiretap.cfg file in a text editor.

2 Locatethe [SECURITY] section. This section contains the BackburnerAdministrators keyword,
which specifies the user accounts with administrator privileges.
For example, the following line assigns administrator privileges to the user account backburner:

BackburnerAdministrators=backburner

3 Edit the BackburnerAdministrators keyword, separating account names with a comma. For
example, the following assigns administrator privileges to the user accounts backburner, apache,
wiretapcentral, and admin:

BackburnerAdministrators=backburner, apache, wiretapcentral, admin
4 Save and exit the file.

5 To verify that administrator privileges have been successfully applied to the user account, first, on the
workstation where the Backburner Manager is installed, restart the Backburner Manager so it picks up
the new settings:

/etc/init.d/backburner restart

6 Next, log in to WiretapCentral as the administrator account, and attempt to suspend a job that belongs
to a different user.

If the suspension operation is successful, the administrator privileges have been applied. If you receive
a “permission denied” error message, the account does not have administrator privileges.

Web Browser Configuration

The WiretapCentral graphical user interface runs in any Web browser that supports the Adobe Flash Player
plug-in, version 9 or later. This includes Mozilla® Firefox® 1.x or later (32-bit), Apple® Safari™ 1.x or later,
and Microsoft® Internet Explorer 6 or later.

If you already have the Adobe Flash Player plug-in installed for your browser, you do not have to perform
any additional configuration to use WiretapCentral. Just open a Web browser, and point it to
http://<hostname>/WiretapCentral.

If your browser does not have the Adobe Flash Player plug-in, you can download it for free from the Adobe
Web site.

NOTE Currently, the Adobe Flash Player for 64-bit Linux systems is still in alpha stage. On Visual Effects and
Finishing workstations, the latest version of the Autodesk DKU (Discreet Kernel Utilities) automatically installs a
32-bit version of Mozilla Firefox with a 32-bit version of the Flash Player. This does not apply to Flare workstations,
as the DKU is not installed for Flare. You can get the alpha version of the 64-bit Linux Adobe Flash Player from the
Adobe Web site.

Verifying Installed Components

After installing and configuring WiretapCentral, and all related components, perform the following procedures
to verify that installation was successful.
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Verifying the Wiretap Gateway

To verify the Wiretap Gateway installation on a machine:

1

Access the file browser in Lustre, or open WiretapCentral in a Web browser:
http://<hostname>/WiretapCentral

In WiretapCentral, locate the machine you want to verify in the Servers panel on the left-hand side,
and make sure the label “Gateway” appears next to the machine name.

In Lustre, locate the machine in the file browser, and make sure the label “Autodesk Wiretap Gateway
Server <version>" appears in the column on the right.

Click the machine name, and make sure you are able to browse the storage device connected to the
machine.

Verifying your Render Farm

To verify your Render Farm from WiretapCentral:

1

Open WiretapCentral in a Web browser:
http://<hostname>/WiretapCentral

Select Backburner Monitor from the Tools menu.
Backburner Monitor opens in a new window.

TIP You can also open Backburner Monitor directly by pointing your Web browser to
http://<hostname>/WiretapCentral/bbmon.html.

Make sure the machine where you set up Backburner Manager appears in the Backburner Manager
drop-down list.

Select the manager for your render farm and then click the Servers tab.
A list of all the Backburner Servers assigned to the selected manager appears.

Make sure the servers you set up are in the list, and that “mio” is listed in the Adapters column for each
of them.

Click the Server Groups tab, and make sure the node groups you set up are listed.

To verify your Render Farm from the Windows Backburner Monitor:

1
2
3

Open Backburner Monitor.
From the Manager menu, select Connect.

Enter the IP or hostname of the machine where you installed Backburner Manager, and verify that you
can connect to the Manager.

Once you are connected to the Manager, expand the “Plugins” branch in the lower-left panel of the
Monitor window, and select “MIO File Import”.

The Servers panel should list all the Backburner Servers where you installed the Media I/O Adapter.

Expand the “Global Groups” branch in the lower-left panel of the Monitor window, and verify that
the server groups you defined are listed there, and that the correct servers are listed under each group.
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Appendix: Wiretap
Gateway Supported Ingest
File Formats

Topics in this chapter:

Overview on page 29
Supported Image Sequence Formats on page 30
Supported Audio File Formats on page 30

]
]
]
B Supported Image Container Formats on page 31

Overview

This appendix lists the image and audio file formats supported by the Wiretap Gateway server, for ingest.
Use the tables in this appendix to determine if a particular digital image sequence or container format can
be recognized by the Wiretap Gateway.

An image sequence is a series of sequentially numbered files, traditionally the result of scanning film stock
at high resolution to produce a digital intermediate. Here, each file contains the digital scan of an individual
frame. Common image sequence formats include Cineon®, DPX and Tiff. The type of image sequence file
on hand is usually revealed by its extension.

In contrast, container formats, also called “wrapper” formats, can contain image sequences (commonly
called streams or essences) and audio, compressed using a variety of compression algorithms (codecs) into a
single file. Container formats do not impose specific video or audio codecs upon the media they contain.
Rather, a container format defines only how the video, audio and other data is stored within the container
itself. Unlike image sequences, it is not possible to tell by looking at the extension what kind of video or
audio is inside a container format.
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Using the Tables

To determine if a particular container format is supported, first locate the section in this appendix for its
container type: QuickTime®, Panasonic® MXF, Sony® MXF, etc. In the table for the container, look for the
codec name or a relevant comment. Associated with each codec supported by a container format is a short
string identifying the specific codec standard used to compress the contents. If you know the codec flag—called
a FourCC code for QuickTime—this is the simplest way to determine if the file can be ingested.

For example, suppose you have a QuickTime (.mov) file that was encoded using the QuickTime “Component
Y'CbCr 4:4:4” video codec (v410 flag), and the IMA audio codec (ima4 flag). First, locate the video codec in
the QuickTime Broadcast table (it's the first entry). Next, locate the audio codec in the QuickTime Audio
table (also the first entry). Since both the audio and video codecs used to encode the contents of the
QuickTime file are present in the tables, the Wiretap Gateway supports ingesting this particular file.

Supported Image Sequence Formats

The Wiretap Gateway server supports ingest of the following image sequence file formats.

File Format Bit Depth Default Extension
Alias® 8-bit als
Cineon® 10-bit cin
DPX 8-bit, 10-bit, and 12-bit dpx
Jpeg 8-bit jrg
Macintosh® Pict 8-bit pict
OpenEXR 16-bit int, 16-bit float, 32-bit float exr
Pixar 8-bit picio
SGI® 8-bit and 16-bit sgi
Softimage® 8-bit pic
TARGA® 8-bit tga
Tdi/Maya® 8-bit and 16-bit iff
Tiff 8-bit and 16-bit tif
Wavefront® 8-bit and 16-bit rla

NOTE OpenEXR 16-bit and 32-bit float is not supported within Lustre.

Supported Audio File Formats

Wiretap Gateway supports ingest of the following audio file formats.

File Format Bit Depth Default Extension
AIFF-C 16-bit, 24-bit, and 32-bit (float) aifc
AIFF 16-bit and 24-bit aiff
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File Format Bit Depth Default Extension

WAVE 16-bit, 24-bit, and 32-bit (float) wav

Broadcast Wave 16-bit, 24-bit, and 32-bit (float) wav

Supported Image Container Formats

Wiretap Gateway supports ingest of the following container formats: QuickTime (.mov), Panasonic P2 MXF
(.mxf), Sony XDCAM MXF (.mxf), Sony XDCAM EX (.mp4) and Red REDCODE RAW (.x3d). For specific
encodings, consult the tables in the sections below.

QuickTime

Wiretap Gateway supports ingest of QuickTime files that adhere to the codec standards presented in the
following tables. For convenience, codecs are loosely grouped by their most common usage: broadcast, file,
web and audio. This should not be understood as a limitation on usage.

QuickTime Broadcast

CODEC Flag Comment
Component Y'CbCr 10-bit 4:4:4 v410 10-bit Packed YUV 4:4:4
Component Y'CbCr 10-bit 4:2:2 v210 10-bit Packed YUV 4:2:2 Blackmagic or AJA-Kona 10-bit
compatible
Component Y'CbCr 8-bit 4:4:4 v308 8-bit Planar YUV 4:4:4
Component Y'CbCrA 8-bit 4:4:4:4 v408 8-bit Planar YUV 4:4:4:4
Component Video yuv2 8-bit Packed YUV 4:2:2 Blackmagic or AJA-Kona 8-bit
compatible
Component Y'CbCr 8-bit 4:2:2 2vuy 8-bit Packed YUV 4:2:2
DV-25 NTSC dvc
DV-25 PAL dvcp, dvpp
DVCPRO 50 NTSC dv5n
DVCPRO 50 PAL dv5p
DVCPRO HD dvh1, dvh2, dvh3, 1920x1080, 24/30 fps1280x720, 24/30/60 fps1920x1080,
dvh5, dvhé, dvhp, 25 fps1280x720 25/50 fps
dvhq
DNxHD avdn 10-bit Avid® DNxHD 220x (220 Mb/sec):

B 1080p, 10-bit, 220 mbps @ 29.97 fps
B 720p 10-bit, 220 mbps @ 29.97 fps
B 1080i, 10-bit, 220 mbps @ 59.94 fps

8-bit Avid DNxHD 220 (220 Mb/sec):
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CODEC Flag

Comment

B 1080p, 8-bit, 220 mbps @ 29.97 fps
B 720p, 8-bit, 220 mbps @ 29.97 fps
B 1080i, 8-bit, 220 mbps @ 59.94 fps

8-bit Avid DNxHD 145 (145 Mb/sec):

B 1080p, 8-bit, 145 mbps @ 29.97 fps

B 720p, 8-bit, 145 mbps @ 29.97 fps

B 1080i, 8-bit, 145 mbps @ 59.94 fps

B 1080i, 8-bit, 145 mbps @ 59.94 fps (thin raster -

1440x1080),

8-bit Avid DNxHD 36 (36 Mb/sec):
B 1080p, 8-bit, 36 mbps @ 24 fps

IMX mx3n, mx3p, mx4n,  MPEG IMX 30 Mb/sec, 40 Mb/sec, 50 Mb/sec
mx4p, mx5n, mx5p
QuickTime File
CODEC Flag Comment
Photo|PEG RTJO RT PhotoJPEG compatible
MJPEG MJPG, mjpg, mjpa, mjpb, |PEG, jpeg, JPEG compatible
dmb1, AVD)
PNG png Portable Network Graphic sequence (no
alpha support)
PNGA pngalpha Portable Network Graphic sequence
(with alpha support)
RGB Uncompressed raw No alpha support
RGBA Uncompressed rawalpha With alpha support
TGA tga TARGA
QuickTime Web
CODEC Flag Comment
MPEG-1 mpg1, MPG1, pim1, PIM1
MPEG-4 mp4v; DivX®; DIV1; divl; MP4S;M4S2;

m4s2; xvid; XVID; XviD; DX50; dx50;
DIVX; MP4V

MSMpeg 4v3 (DivX)

DIV1, divl, MPG4, mpg4, DIV2, div2,
MP42, mp42, DIV3, div3, DIV4, div4,
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CODEC

Flag Comment

DIV5, div5, DIV6, dive, MPG3, mpg3,
MP43, mp43, AP41, ap41, MJPG

QuickTime Planar RGB 8BPS

Apple® Video rpza

Apple Graphics smc

Apple Animation rle With alpha support
Cinepak cvid

QuickTime Audio

Audio CODEC CODEC Flag Comment

IMA 4:1 ima4

Raw 8-bit audio rawaudio

Twos twos 16-bit PCM (Big Endian)
Ulaw ulaw

Sowt sowt 16-bit PCM (Little Endian)
A-law 2:1 alaw

16-bit PCM in16

Linear PCM (QT 7) Ipcm

Ogg Vorbis vorbis qt4l compatible

Ogg Vorbis vorbis_qgt qtcomponents compatible
MPEG-2 Layer 2 Audio mp2

QDM2 Audio qdm2

Apple lossless alac

McRowsoft ADPCM adpcm (ms)

ADPCM ima WAV

ima adpcm (wav)

MXF

Wiretap Gateway supports the ingest of MXF files associated with the Panasonic DVCPRO P2 and Sony
XDCAM and Avid Media Composer® implementations of the format.
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Avid DNxHD MXF

Wiretap Gateway supports the ingest of DNxHD media in the Avid MXF wrapper, as presented in the following
table.

NOTE File-based workflows originating from Media Composer 3.05 and later are fully supported. MXF files
originating from a non-file workflow may result in error.

CODEC Flag Comment

DNxHD avdn 10-bit Avid DNxHD 220x (220 Mb/sec):
B 1080p, 10-bit, 220 mbps @ 29.97 fps

B 720p, 10-bit, 220 mbps @ 29.97 fps
W 1080i, 10-bit, 220 mbps @ 59.94 fps

8-bit Avid DNxHD 220 (220 Mb/ sec):
B 1080p, 8-bit, 220 mbps @ 29.97 fps

B 720p, 8-bit, 220 mbps @ 29.97 fps
B 1080i, 8-bit, 220 mbps @ 59.94 fps

8-bit Avid DNxHD 145 (145 Mb/ sec):
B 1080p, 8-bit, 145 mbps @ 29.97 fps

B 720p, 8-bit, 145 mbps @ 29.97 fps
B 1080i, 8-bit, 145 mbps @ 59.94 fps
W 1080i, 8-bit, 145 mbps @ 59.94 fps (thin raster - 1440x1080)

8-bit Avid DNxHD 36 (36 Mb/sec):
B 1080p, 8-bit, 36 mbps @ 24 fps

Panasonic DVCPRO P2 MXF

P2 CODEC CODEC Flag Comment
AVC-Intra 50 AVC-1 50 Panasonic P2
AVC-Intra 100 AVC-1100 Panasonic P2
DV 25 DV 25

DVCPRO DVCPRO

DVCPRO 50 DVCPRO50

DVCPRO HD DVCPROHD

Sony XDCAM MXF

XDCAM CODEC CODEC Flag Comment
MPEG-2 IMX 30 IMX 30 XDCAM
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XDCAM CODEC CODEC Flag Comment

MPEG-2 IMX 40 IMX 40 XDCAM
MPEG-2 IMX 50 IMX 50 XDCAM
MPEG-2 long-GOP XDCAM HD XDCAM HD
Sony XDCAM EX

The following Sony XDCAM EX format is supported for ingest.

CODEC Comment

MPEG-2 Long-GOP MP4

Red REDCODE RAW

All Red REDCODE™ RAW(.r3d) file resolutions and qualities encoded by the Redcode codec are supported
for ingest by the Wiretap Gateway. Audio is not currently supported.
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